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Getting Started

k Software Covered by This Manual
• This manual covers the following software. 

fx-9860GII Manager PLUS

fx-9750GII Manager PLUS

GRAPH75+ E Manager PLUS

GRAPH35+ E Manager PLUS

• Emulator Graphic

 The following shows the emulator graphics displayed by each type of software. 

fx-9860GII
Manager PLUS

GRAPH75+ E 
Manager PLUS

GRAPH35+ E 
Manager PLUS

fx-9750GII
Manager PLUS

• Though the calculator operations you perform with the emulator graphic are different for each 
type of software, operation of the software itself is the same in all cases. 

• The operations in this manual are based on the fx-9860GII Manager PLUS software. You can 
perform the same operations for other software.
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k About fx-9860GII Manager PLUS
• fx-9860GII Manager PLUS is an emulator that lets you perform fx-9860GII operations on your 

computer. 

• You can record key operations you perform on the emulator as “Key-Log records”, and edit Key-
Log records as required.

• The keys on the Key-Log editor screen as well as the emulator LCD screen contents can be 
pasted into other applications. This means that emulator data can be used to create assignments, 
tests, and other materials.

• A presentation feature lets you play back saved Key-Log records.

• You can connect your fx-9860GII unit to your computer and display its contents on your computer 
screen.

Important!
• Be sure to install the software before you connect fx-9860GII to your computer. Connecting 

before you install the software can result in improper operation.

k Using This Manual 
• For details about operation of the fx-9860GII Graphic Scientific Calculator, see the user 

documentation that comes with the calculator. 

• The procedures in this manual assume that you are already familiar with the following standard 
computer operations. 

- Menu operations using the mouse, including: clicking, double-clicking, dragging, etc. 

- Text input using the keyboard

- Icon operations, general window operations, etc. 

- If you are not familiar with these types of operations, refer to the user documentation for your 
computer.

• The screen shots shown in this manual are all from the English version of Windows® 8.1. 

• Note that the actual appearance of the screen that appears when using this software depends on 
your computer system setup and on the operating system you are using. 

• Screen shots shown in this User’s Guide are intended for illustrative purposes only. The actual 
text and values that appear on display may differ from the examples shown in this User’s Guide.



EN-3

k System Requirements
Operating Systems: Windows 7 (32-bit/64-bit), Windows 8.1 (32-bit/64-bit), Windows 10 (32-bit/

64-bit)
Your hardware configuration needs higher than functionalities that operating 
system recommends.

Computer: Computer with one of the Windows operating systems pre-installed 
(Excluding computers with an upgraded operating system and self-built 
computers.)

Disk Space: 100MB for installation and uninstall

Note: Actual requirements and product functionality may vary based on your 
system configuration and operating system.

Other: Video adapter and display must support resolution of XGA (1024×768) or 
higher, 16 bit or higher system color.
Internet Explorer® 7 or later.
Adobe® Reader® 8.0 or later.
Microsoft® Excel® 2007 or Microsoft Excel 2010

Note
• For the latest information about system requirements, visit the website at the URL below:

https://world.casio.com/support/os_support/

• Microsoft, Windows and Excel are registered trademarks or trademarks of Microsoft Corporation 
in the United States and/or other countries.

• Adobe and Reader are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and/or other countries. 

• Company and product names used herein are trademarks of their respective owners.

• Note that trademark ™ and registered trademark ® are not used within the text of this user’s 
guide.

https://world.casio.com/support/os_support/
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1. Installing and Uninstalling the Software

To install the software

1. On your computer, double-click the fx-Manager PLUS application EXE file.

2. Perform operations as instructed by the text that appears on the screen.

To uninstall the software
Use Windows Control Panel to uninstall the software.

To start up the software

1. On your computer’s desktop, click the “fx-Manager PLUS Subscription” icon. 

• Starting up this application for the first time will display a dialog box for selecting a calculator 
model. Select a calculator model and then click [OK]. 
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2. Screen Configuration
The following shows the fx-9860GII Manager PLUS screen.

Menu Bar
Toolbar

Emulator

Status Bar

File Display Area

Key Log window Bitmap File window (a capture 
of the emulator LCD screen)

* When you have both the emulator window and Key-Log (or bitmap file) window open on the 
display, the emulator window always will be displayed on top.
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Menu Bar
• If a menu command can also be executed by clicking a toolbar button, the applicable toolbar 

button is also provided. 

k File Menu

Menu
Toolbar 
Button

Description

New Creates a new Key-Log file. 

Open... Opens an existing file.

Close Closes the currently open file. 

Capture Screen Captures the emulator screen. 

Save
Saves the current work file, overwriting the previous 
(unedited) version. 

Save As... Saves the current work file under a new name. 

Print... Prints the currently displayed bitmap file. 

Print Preview Displays a preview of the print image. 

Print Setup... Displays the print setup dialog box. 

(File History) Shows up to four of the last files you worked on. 

Change 
Calculator Model 
and Exit...

Displays a dialog box for selecting a calculator model 
to be emulated. Clicking [Save and Exit] will exit this 
application. The next time you start up this application, 
the emulator that was selected when you clicked [Save 
and Exit] will appear on the display.

Exit Exits this application. 
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k Edit Menu

Menu
Toolbar 
Button

Description

Undo Undoes the last operation. 

Redo Redoes the last undone operation. 

Cut Moves the selected data to the clipboard.

Copy Copies selected data to the clipboard.

Paste Pastes the clipboard contents. 

Clear Deletes the selected data.

Select All Selects all Key-Log records. 

* The Edit menu is disabled during emulator operation.

k View Menu

Menu Submenu   Description

Calc Key Normal Selects normal-size calculator keys.

Large Selects large-size calculator keys.

Calc Screen ×1 Specifies an actual size display. 

×2 Specifies a 2X size display. 

×3 Specifies a 3X size display. 

×4 Specifies a 4X size display. 

×5 Specifies a 5X size display. 

Tool Bar Standard Toggles display of the standard toolbar on and off.

Log Toggles display of the log toolbar on and off.

Edit Toggles display of the edit toolbar on and off.

Bitmap Toggles display of the bitmap toolbar on and off.
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k Key-Log Menu

Menu
Toolbar 
Button

Description

Add 
Adds a new Key-Log record (Key-Log editor mode 
only). 

Delete
Deletes the currently displayed Key-Log record (Key-
Log editor mode only). 

Emulator Enters the emulator mode. 

Editor Enters the Key-Log editor mode. 

Auto Play Starts Key-Log auto playback. 

Step Play Starts Key-Log manual playback. 

Stop Stops Key-Log playback or recording. 

Pause Pauses Key-Log playback. 

Record Starts Key-Log recording. 

Insert Pause
During Key-Log editing, inserts a pause character into 
Key-Log playback (Key-Log editor mode only). 

k Window Menu

Menu Description

Tiled Displays all windows in a tiled configuration. 

Horizontal Displays all windows in a horizontal line. 

• The Window menu also shows the names of files that you have open. When you have multiple 
files open, the file name at the top of the list is the one you are currently working with the active 
file.
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k Tools Menu

Menu
Toolbar 
Button

Description

Screen Receiver Starts up Screen Receiver. 

Options... Displays a dialog box for configuring optional settings.

k Help Menu

Menu Submenu Description

Manual Calculator Links to https://world.casio.com/manual/calc/. 
Download the Calculator User’s Guide there.

Manager PLUS Displays the fx-Manager PLUS User’s Guide. 

Activation Displays the Activation User’s Guide.

License Displays the end user license agreement. 

About... Displays version information. 

Activation... Displays the activation screen. For details, see the 
Activation User’s Guide.

Toolbar
• The toolbar buttons correspond to menu bar commands. See the section of this manual that 

explains the menu bar for details about each button’s function. 

k Standard Toolbar

Editor

   New  Open  Save   Print  Print     Cut  Copy  Paste  Undo  Redo  Screen    Emulator
                                                  Preview                                                  Receiver

k Log Toolbar

   Play    Step    Stop    Pause   Record

https://world.casio.com/manual/calc/
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k Edit Toolbar

   1   2    3                                  4                                           5                          6

1 Add 

2 Delete

3 Insert Pause

4 Font ... Specifies the font of input text. 

5 Font Size ... Specifies the font size of input text. 

6 Key-Log Record ... Selects the Key-Log record to be played back or edited. 

k Bitmap Toolbar

       1        2                 3

1 Capture Screen

2 Outer Frame
Specifies an outer frame for screen captures. 

3 Bitmap Size
Specifies the bitmap size. A setting of 1 through 10 can be selected. 

Status Bar

               1                                                                                                                                  2            3

1 Help text is displayed here.

2 Displays the process currently being performed. 

3 Toggles between the insert and overwrite modes.  
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3. Emulator Mode and Key-Log Editor Mode
fx-9860GII Manager PLUS has two modes. 

You can use either of the following to operations to select the mode you want. 
• On the [KeyLog] menu, select either [Emulator] or [Editor]. 

• On the standard toolbar, click  or . 

Emulator Mode

Use this mode when you want to perform mainly emulator operations. 

Key-Log Editor Mode

Use this mode when you want to perform mainly Key-Log data operations.
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4. Emulating fx-9860GII Calculator Operation 
• The emulator makes it possible to mimic fx-9860GII calculator operation using your computers 

mouse and keyboard. 

• For details about emulator operations, see the fx-9860GII User’s Guide. 

• Note that some emulator functions are different from the functions of the fx-9860GII calculator. 
For details, see “9. Differences between fx-9860GII Calculator and fx-9860GII Manager PLUS 
Functions” (page EN-27). 

k Using the Emulator
• Key operations are identical to those you perform on the calculator. 

• Operation results appear on the LCD screen. 

LCD Screen

Keypad

In the Emulator Mode, you use your computer keyboard to operate the emulator. The following 
explains the keyboard keys you should use to perform each emulator key operation.

(1) Computer keyboard keys that have the same key markings as the emulator keys

 a—j, ., +, -, (, ), ,, M, 1—6, f, c, d, e
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(2) Computer keyboard keys that have different key markings as the emulator keys

Computer Key Emulator Key

[Tab] A

[Insert] !

[Home] K

[Page Up] J

[Page Down] m

[End] a

[Esc] J

[Delete] D

[Back Space] D

[Enter] w

[*] *

[/] /

k Changing the Size of the Emulator
You can select one of two sizes for the emulator’s keypad and one of five sizes for the display area. 

To specify the size of the keypad

1. On the [View] menu, select [Calc Key].

2. From the submenu that appears, select the keypad size you want. 

To specify the size of the LCD screen

1. On the [View] menu, select [Calc Screen].

2. From the submenu that appears, select the LCD screen size you want. 
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k Using the Floating Emulator Feature
• You can drag the LCD screen and the keypad to any location you want on your computer screen. 

• You can display the emulator LCD screen and its keypad in their own windows that are separate 
from the main window. 

To make the LCD screen and/or keypad a floating window

1. Double-click the LCD screen and/or keypad. 

2. Drag the LCD screen and/or keypad to the left so it is outside of the main window, and drop it 
there. 

k Moving the LCD Screen and Keypad Back into the Main Window
• Perform the following steps to move the LCD screen and/or keypad back into the main window 

from independent floating windows. 

- Double-click the floating LCD screen and/or keypad. 

- Drag the LCD screen and/or keypad back to the left side of the main window.

Important!
• You can return an independent floating window to the main window by dragging the floating 

window to the left side of the main window only. Dragging top, bottom, or right side of the main 
window will not work.
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k Capturing the Emulator LCD Screen Image 
• You can use the following procedure to capture an image of the emulator LCD screen.

To capture the emulator LCD screen image

1. On the [File] menu, select [Capture Screen] to display a capture of the emulator LCD screen 
(page EN-6). 

• You could also click  on the bitmap toolbar. 

• You can also add a frame to the captured image or change the image zoom factor, if you 
want. For details, see “Bitmap Toolbar” (page EN-11) and “LCD Screen Capture Settings” 
(page EN-21). 

• If either a window containing of a captured image or the Key-Log screen is currently 
maximized (using the Windows maximize command) on your computer display, any window 
produced by the capture operation will also be maximized. This is true regardless of the size 
setting specified for screen capture on the Options dialog box (page EN-21).

2. Select the captured screen image window and then click  to save it to a file. 

* You can save a screen capture as either of the two following file formats.

• Monochrome bitmap format

• JPEG format
This application uses libraries by the Independent JPEG Group.

k Opening a Saved LCD Screen Image
• You can open a saved LCD screen image and display it on your computer. You can have multiple 

screen images open at the same time. 

• LCD screen images can be copied and pasted into other applications in order to create operation 
example handouts, assignments, etc. 

* Only bitmap files can be opened using this procedure. Opening of JPEG files is not supported.

To copy an LCD screen image and paste it into another application

1. Click  and then open the file that contains the LCD screen image you want to copy. 

2. Select the LCD screen image window and then click  to copy it to the clipboard. 

3. Open the other application and then paste the contents of the clipboard.



EN-17

5. Using the Emulator Key-Log 
This section explains how to use the Key-Log, which is a log of the emulator’s key operations. It 
also covers playback of recorded key operations and editing of Key-Log records. 
All of the operations in this section are performed using toolbar buttons.

k Key-Log File Structure 
A Key-Log file can contain multiple Key-Log records. 
Key-Log records contain recorded key operations and text. 
The following shows the Key-Log file structure.

Mathematics

Key-Log File

Key-Log Records

Key

Text Data

bw

• You can assign names (up to 20 single-byte characters) to Key-Log records.  

Important!
• Key-Log data processing can take a long time when there is a lot of data. This is normal and does 

not indicate malfunction. 

• Only key operation procedures are stored in a Key-Log file. Because of this, replaying Key-Log 
contents starting from an initial screen that is different from the one that was displayed when the 
data was originally stored may produce different results.  

• A key operation may not be stored to a Key-Log if you click it while an emulator calculation 
operation is in progress. 
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To record emulator key operations using Key-Log

1. Click  to start Key-Log recording. 

2. Perform operations on the emulator. 

Keys appear in the sequence you press them.

3. Click  to stop Key-Log recording. 

4. Click  to save the Key-Log file. 

To perform Key-Log auto play of a recorded key operation 

1. Click  and then open the Key-Log file you want to play. 

2. Click  to start playback. 

The next key to be 
played back is orange.

Played key operations 
are blue. 

The last played 
key is blue. The next key to be played is framed in orange.

• Click  to pause playback. 

 Click  to restart playback after pausing it. 
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3. To stop playback, click  . Stopping playback causes all keys to return to their original colors. 

Note 
• You can use the optional settings dialog box (page EN-21) to configure playback settings like the 

key playback interval following a pause, the color of playback keys, etc. 

• Simultaneous playback of multiple Key-Log files is not supported. If you try to open a Key-Log file 
while another Key-Log file is already open, the currently open file will close automatically. If the 
currently open file has been edited, a message “At least one file has unsaved edits. Save edits?” 
will appear asking if you want to save it before closing. 

To playback a Key-Log record manually (STEP playback) 

1. Click  and then open the Key-Log file you want to play. 

2. Click  to play the first key operation in the Key-Log. 

3. Keep pressing  to play Key-Log contents one step at a time. 

4. To stop playback, click . 

To edit a Key-Log record 

1. Click  and then open the Key-Log file you want to edit. 

2. Select the Key-Log record you want to edit. 

                                                             Select the Key-Log record from this menu.

3. Edit the key operations and text of the Key-Log record. 

• You can use normal text input and editing operations to edit the keys in a Key-Log record. 

• When inputting text, you can specify the font and font size you want to use. 

                                     Font                                                       Font Size

4. Click  to save the Key-Log file. 
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To add a Key-Log record to the currently open Key-Log file

After opening the Key-Log file to which you want to add the record, click .  

This automatically assigns the Key-Log record a name (Example: “Data1”) and displays it in the 
menu. 

To rename a Key-Log record 

1. Select the Key-Log record you want to rename from the menu. 

2. Click the name of the Key-Log record and then change it. 

3. Press the [Enter] key. 

To delete a Key-Log record

1. Select the Key-Log record you want to delete from the menu. 

2. Click  to delete the selected Key-Log record and display the next one. 

Note
• There must be at least one Key-Log record in memory. You will not be able to delete a Key-Log 

record if it is the only one left in memory. 

k Inputting a Pause Character 
A pause character causes Key-Log playback to pause automatically when it reaches the character. 

To input a pause character, click . 

k Copying Keys or Text and Pasting It into Another Application 
Keys and text can be copied and pasted into other applications in order to create operation 
example handouts, assignments, etc. 

To copy keys or text and paste it into another application

1. Drag the cursor across the keys or text you want to copy. 

2. Click  to copy the selected keys or text to the clipboard. 

3. Open the other application and then paste the contents of the clipboard. 
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6. Configuring Options Dialog Box Setting

k LCD Screen Capture Settings 

1

2

1 Select this option to add a frame to an LCD screen capture. 

2 Specifies the screen size during LCD screen capture. You can select a setting in the range of 1 
through 10. 

k Key-Log Playback

1

2

3

4

1 Select this option to highlight the current key in blue. 

2 Select this option to frame the next key in orange. 

3 Specifies how much time should be allowed to elapse to resume paused playback. You can set 
an interval in the range of 10 seconds to 10 minutes in 10-second steps. 

4 Specifies the key playback interval during auto play. You can set an interval of 0.1 second, or 
any interval in the range of 0.5 to 5 seconds, in 0.5-second steps.
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k Spreadsheet Setting

1

2

1 You can configure Copy & Paste so either values or Excel formulas are pasted into a 
spreadsheet. 

        Paste Formulas ... Pastes formulas.

        Paste Values ... Pastes values only.

2 You also can specify the language to be used when pasting to Microsoft Excel. 
Whenever you copy from Spreadsheet and paste to an Excel formula, the formula will be 
converted to the selected language.

Example: CellIf(   IF( : English
  SI( : Spanish
  SI( : French
  WENN( : German 

 When using the following language versions of Excel, configure the Excel Language setting as 
shown below.

Arabic: English2
Slovenian: English3
Portuguese (European): PortugueseEu
Portuguese (Brazilian): PortugueseBr

• For details about copying and pasting Excel formulas, see page EN-32.
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7. Other Functions

Printing
• You can use the following procedure to print LCD screen captures. 

1. Click the window of the LCD screen capture that you want to print to select it. 

2. Click . This will display the Print dialog box. 

3. Click [OK] to start printing. 

Important!
• Each screen image is printed on a separate page. 

• Images are printed in accordance with width setting of the paper size selected on the Print dialog 
box. 

• If you are printing a bitmap image that was created using another application and does not fit 
within the preview area, only the part within the preview area will be visible. Also, only that part 
will be printed. 
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k Print Preview
• Selecting [Print Preview] on the [File] menu displays the print preview image. 

  1                      2    3    4

1 Displays the Print dialog box. 

2 Enlarges the preview image. 

3 Reduces the size of the preview image. 

4 Closes the print preview window image.  

k Print Setup Dialog Box 
• Selecting [Print Setup] on the [File] menu displays the Print Setup dialog box. 
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Shortcut Menu
• Right-clicking the mouse displays one of the shortcut menus shown below. 

• During Key-Log Editing

• During Bitmap Display of the Calculator 
Screen 

A screen zoom operation affects only the screen where 
you display the shortcut menu. If you have multiple 
screens on the display, the other screens are not affected 
by the zoom operation. 

• When Using the Emulator

• On the Emulator Keypad
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8. File Types Supported by fx-9860GII 
Manager PLUS

• fx-9860GII Manager PLUS supports files with the file name extensions described below. 

Extension Description Supported Software

g1m Emulator or calculator user memory 
data file (variables, programs, etc.)

All fx-Manager PLUS software

g2m Emulator or calculator user memory 
data file (variables, programs, etc.)

Software after fx-Manager PLUS Ver. 2.0

g1e eActivity file All fx-Manager PLUS software (not 
including fx-9750GII Manager PLUS and 
GRAPH35+ E Manager PLUS)

g2e eActivity file Software after fx-Manager PLUS Ver. 2.0 
(not including fx-9750GII Manager PLUS 
and GRAPH35+ E Manager PLUS)

g1a Add-In application All fx-Manager PLUS software (not 
including fx-9750GII Manager PLUS and 
GRAPH35+ E Manager PLUS)g1l Add-In message

g1n Add-In menu

g1k fx-9860GII Manager PLUS Key-Log 
file

All fx-Manager PLUS software

bmp Bitmap file All fx-Manager PLUS software

Note
• You can use the MEMORY application to import all file types (except g1k) into the emulator.  

• Files with the extension g1k can be used in Key-Log files.



EN-27

9. Differences between fx-9860GII Calculator 
and fx-9860GII Manager PLUS Functions

k eActivity Applications (SD Card Access) (Not included on the fx-
9750GII/GRAPH35+ E)

Calculator: SD card access supported.

Emulator: Performing an operation that accesses an SD card displays a dialog box, which can 
be used to open an eActivity saved on your computer or save an eActivity on your 
computer. Trying to perform an optimize operation while accessing an SD card will 
cause an error. 

Example:  To use the emulator to create a new eActivity file (ABC.g2e) on an SD card (actually 
your computer’s hard disk)

1. From the Main Menu, enter the e·ACT mode. 

2. Click 6(SD).

• This displays the SD access screen.

3. Click 2(NEW).

• This displays a file name input dialog box.
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4. Select the location on your computer where you want to save the file, input the file name 
(ABC.g2e), and then click [Save].

• This displays the eActivity file editing screen.

* Subsequent operations are identical to those you would perform on the calculator.
* After you are finished, perform the required operation to save the file.

Example:  To use the emulator to open an eActivity file (ABC.g2e) that is stored on an SD card 
(actually your computer’s hard disk)

1. From the Main Menu, enter the e·ACT mode.

2. Click 6(SD).

• This displays the SD access screen.

3. Click 1(OPEN).

• This displays a file selection dialog box.

4. Type in the file name (ABC.g2e), and then click [Open].

• This displays the eActivity file editing screen.
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k LINK Application
Calculator: Data transfer execution supported.  

Emulator: Data send/receive, and configuring cable, wakeup, and capture settings are not 
supported.  

k MEMORY Applications (SD Card Access)
Calculator: Data save to and data read from an SD card supported. (fx-9860GII SD only)

Emulator: Performing an operation that accesses an SD card displays a dialog box, which can be 
used to store data to a computer file and to import a file. 
Trying to perform the SD card optimize operation on the emulator will cause an error.

 SD card (actually your computer’s hard disk) access can be performed by selecting 
either a folder or a file. What you select depends on the type of operation you want to 
perform.

When to select a folder on your computer’s hard disk
Select a folder on your computer’s hard disk when you want to perform any one of the following 
operations.

• Copying main memory or storage memory contents to an SD card (actually your computer’s hard 
disk)

• Loading backup data from an SD card (actually your computer’s hard disk) 

• Saving backup data to an SD card (actually your computer’s hard disk)

Example: To use the emulator to save backup data to your computer

1. From the Main Menu, enter the MEMORY mode.

2. Click 4(BKUP)1(SAVE).

• This displays the save location selection screen.
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3. Click 2.

• This displays the folder selection screen.

4. Select the folder you want and then click [OK].

• The backup data is saved to the folder you select.

When to select a file on your computer’s hard disk
Select a file on your computer’s hard disk when you want to perform the following operation.

• Copying a file on an SD card (actually your computer’s hard disk) to main memory or storage 
memory

1. From the Main Menu, enter the MEMORY mode.

2. Click 3(SD).

• This displays the file selection screen.

3. Select the file you want and then click [Open].

• This displays the main memory/storage memory selection screen.

• Selecting a destination (main memory or storage memory) will start the copy operation.
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k SYSTEM Applications (Contrast, Auto Power Off, Reset) 
Calculator: Contrast adjustment, auto power off setting configuration, and SD card formatting 

supported. 

Emulator: Contrast adjustment, auto power off setting configuration, and SD card formatting not 
supported.  

k Installing an Add-In (Not included on the fx-9750GII Manager PLUS/
GRAPH35+ E Manager PLUS)

You can perform the following procedure on the emulator to install an Add-In application, Add-In 
language, or an eActivity. 

Example: To install an Add-In application

1. From the Main Menu, enter the MEMORY mode. 

2. Click 3(SD). 

• This displays a dialog box for opening a file. 

3. Select the Add-In file you want and then click [Open]. 

4. Click 2. 

5.  Click E. 
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6.  Click J. 

7.  Click m. 

• The icon of the application you just installed should be 
visible on the Main Menu. 

• Some Add-In applications may act differently on the fx-9860GII calculator than they do on the 
emulator. 

k LIGHT Key (fx-9860GII/GRAPH75+ E only)
Calculator: Turns on the display backlight. 

Emulator: No operation

k OFF (! + A) 
Calculator: Turns off power. 

Emulator: Does not turn off the emulator. (! + A does not perform any operation.)

k COPY & PASTE
Calculator: COPY & PASTE supported on the calculator. 

Emulator: COPY & PASTE supported on the calculator, and between the calculator and other 
applications running on the computer. 

Copy and paste of fx-9860GII calculator-specific input codes between fx-9860GII Manager PLUS 
and other applications is not supported in some cases.

Supports copy and paste between an emulator spreadsheet and an Excel spreadsheet running on 
your computer. (Not included on the fx-9750GII Manager PLUS) 

• Copy and paste of the following formulas is supported between an emulator spreadsheet and an 
Excel spreadsheet running on your computer. 

+, –, `, /, ^, =, <>, >, <, >=, <=, $, :
IF, MIN, MAX, AVERAGE, MEDIAN, SUM, PRODUCT
LOG, FACT, POWER, SQRT, LOG10, LN, PI
SIN, COS, TAN, ASIN, ACOS, ATAN, SINH, COSH, TANH, ASINH, ACOSH, ATANH
ABS, GCD, LCM, MOD, TRUNC, INT, ROUND, PERMUT, COMBIN, RAND, NOT, AND, OR
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The table below shows how some formulas may be modified automatically when a paste operation 
is performed.

Modified Formulas

Spreadsheet Paste Operation* Excel

� ⇔ `

� ⇔ /

≠ ⇔ <>

> ⇔ >=

< ⇔ <=

Omitted multiplication sign → `

CellIf( ⇔ IF(

CellMin( ⇔ MIN(

CellMax( ⇔ MAX(

CellMean( ⇔ AVERAGE(

CellMedian( ⇔ MEDIAN(

CellSum( ⇔ SUM(

CellProd( ⇔ PRODUCT(

logab(#1,#2 ⇔ LOG(#2,#1

#12 → #1^2

#1–1 → #1^–1

#1! ⇔ FACT(#1)

#1X'#2 → #2^(1/#1)

#1{#2 → #1/#2 

'#1 ⇔ SQRT(#1)

3'#1 → #1^(1/3)

log #1 ⇔ LOG10(#1)

ln #1 ⇔ LN(#1)

e^#1 ⇔ EXP(#1)

10#1 → 10^#1

π ⇔ PI()

E#n1 → 10^#n1

#n1E#n2 → #n1`10^#n2

#1^#2 ← POWER(#1, #2)

sin #1 ⇔ SIN(#1)

cos #1 ⇔ COS(#1)

tan #1 ⇔ TAN(#1)

sin–1 #1 ⇔ ASIN(#1)

cos–1 #1 ⇔ ACOS(#1)

tan–1 #1 ⇔ ATAN(#1)
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Spreadsheet Paste Operation* Excel

sinh #1 ⇔ SINH(#1)

cosh #1 ⇔ COSH(#1)

tanh #1 ⇔ TANH(#1)

sinh–1 #1 ⇔ ASINH(#1)

cosh–1 #1 ⇔ ACOSH(#1)

tanh–1 #1 ⇔ ATANH(#1)

Abs #1 ⇔ ABS(#1)

GCD( ⇔ GCD(

LCM( ⇔ LCM(

MOD( ⇔ MOD( 

Int #1 ⇔ TRUNC(#1)

Intg #1 ⇔ INT(#1)

RndFix( ⇔ ROUND(

#1P#2 ⇔ PERMUT(#1,#2) 

#1C#2 ⇔ COMBIN(#1,#2) 

P( ⇔ NORMSDIST(

Ran# ⇔ RAND() 

Not #1 ⇔ NOT(#1) 

#1 And #2 ⇔ AND(#1,#2)

#1 Or #2 ⇔ OR(#1,#2)

* The following are the meanings of the symbols in the “Paste Operation” column of the above 
table.

 ⇔: Either way

 →: From emulator spreadsheet to Excel

 ←: From Excel to emulator spreadsheet

• For information about how formulas are modified when using a non-English version of Excel, see 
the Formula List (page EN-35).

• If a paste operation includes an unsupported formula or an operation whose value causes an 
error, only the final value will pasted without the formula. 

• If a formula being pasted into an emulator spreadsheet exceeds 255 bytes after being modified 
as described in the table above, only the final value will be pasted without the formula. 

• An error will occur if the argument of a formula is outside the argument range of the location 
where it is being pasted. 

• When pasting a formula with a relative cell reference (such as: =A1+1) from Spreadsheet to 
Excel, make sure you paste it into the cell with the same name as the cell you copied it from. 
Copying it into a different cell will cause an incorrect cell reference. 
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Note 
Some mathematical functions do not copy and paste correctly between Microsoft Excel 2010 and 
the Emulator Spreadsheet. Change the functions below in Excel to the proper function names.

Pasted Function Name
Correct Function Name 
(Rename as shown below.)

Czech NE NENÍ

Danish MIDDEL GENNEMSNIT

STØRSTE.FÆLLES.DIVISOR FÆLLES.DIVISOR

HELTAL HEL

Hungarian GCD LKO

LCM LKT

Dutch AFRONDEN AFRONDING

WORTEL VWORTEL

Norwegian STØRST MAKS

Polish LCM NAJW.WSP.DZIEL

MOD NAJMN.WSP.WIEL

Portuguese
(Brazilian)

MÍNIMO MÍN

MULT PRODUTO

DIST.NORMP DISTNORMP

FATORIAL FATO

TRUNCAR TRUNC

Turkish TOPLA TOPLAM

k Examination Mode
Calculator: Examination Mode supported.

Emulator: Examination Mode not supported.
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10. Using Screen Receiver to Display the 
Calculator Screen Image on 
Your Computer 

Important!
• A USB driver install dialog box will appear the first time you connect the fx-9860GII calculator to 

your computer with the USB cable. Follow the instructions that appear on the dialog box. Screen 
Receiver will not operate properly if you cancel the install operation. 

k To display the calculator screen image on your computer 

1. Use the USB cable that comes with the calculator to connect the calculator to your computer.

• For the fx-9750GII and GRAPH 35+, you will need to purchase the separately available 
FA-124USB.

• This will display a dialog box on the calculator screen. 

2. On the calculator, press 4(ScreenRecv).

3. On the [Tools] menu, select [Screen Receiver], or click  on the toolbar. 

4. A short while after Screen Receiver starts up, an image of the calculator screen will appear on 
your computer. 

5. Operate the calculator. When you do, the calculator screen image will change in real time on 
your computer. 

6.  You can enlarge the calculator screen image by clicking  and reduce its size by clicking .

7.  To close the calculator screen image, click . 

8.  Disconnect the USB cable. 
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Important!
• If the calculator screen does not appear, try disconnecting the USB cable and then restart the 

above procedure from the beginning. If the calculator screen still does not appear, check the 
points described below. 

If this is the problem: Do this:

The USB cable is disconnected. Reconnect the USB cable. 

There are multiple calculators connected. Disconnect the other calculators so there is 
only one left connected. 

There is another CASIO product connected 
with a USB cable.

Disconnect the other CASIO product. 

k Screen Receiver Menus

Screen Receive Menu

Menu Toolbar Button Description

Start Displays the calculator screen image.

Stop Closes the calculator screen image. 

Exit Exits Screen Receiver.
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View Menu

Menu Submenu
Toolbar
 Button

Description

Expand Enlarges the calculator screen image. 

Reduce Reduces the size of the calculator screen image. 

Zoom* ×1 Shows the calculator screen image in actual size. 

×2 Shows the calculator screen image is ×2 size. 

×3 Shows the calculator screen image is ×3 size. 

×4 Shows the calculator screen image is ×4 size. 

×5 Shows the calculator screen image is ×5 size. 

×6 Shows the calculator screen image is ×6 size. 

×7 Shows the calculator screen image is ×7 size. 

×8 Shows the calculator screen image is ×8 size. 

×9 Shows the calculator screen image is ×9 size. 

×10 Shows the calculator screen image is ×10 size. 

Toolbar Toggles display of the toolbar on and off. 

Status Bar Toggles display of the status bar on and off.

* The allowable zoom size is limited by the resolution of the computer.

Help Menu

Menu Submenu Description

Manual Calculator Links to https://world.casio.com/manual/calc/. 
Download the Calculator User’s Guide there.

Manager PLUS Display the fx-Manager PLUS User’s Guide. 

License Displays the end user license agreement. 

About Displays version information.

https://world.casio.com/manual/calc/
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11. Error Message Table

k fx-Manager PLUS

Message Description Required Action

An error occurred while 
reading the file <file name>.
The file may be corrupted.

Wrong file format. Check the file to see if it is 
corrupted.

There is no more playable 
data.

There are no playable keys to 
the right of the input cursor.

Move the input cursor to the 
left of the keys you want to 
play back, and perform the 
play operation.

You cannot delete all Key-Log 
records at once.
Before deleting the selected 
record, first add new record.

You are trying to delete all 
Key-Log records, which is not 
allowed.

To delete all of the current 
records, first add a different 
record. At least one Key-Log 
record must be remaining in 
memory. 

<file name>
This file is read-only.
Use a different file name.

You are trying to save a read-
only Key-Log file after editing 
or recording to it. 

Save the Key-Log file under a 
different file name. 

A problem occurred while 
adding a Key-Log record.
After confirming there is 
enough memory capacity to 
store the record, try again.

Some problem occurred while 
adding a Key-Log record. 

Make sure there is enough 
free memory remaining to 
complete the operation and try 
again. 

A problem occurred while 
writing to the file <file name> 
because not enough disk 
space is available.
Check the remaining capacity 
of your disk and try again.

There is not enough disk space 
available to save the file. 

Make sure there is enough 
free memory available and try 
again.

This application cannot be 
started up because the DLL 
version is wrong.
This may be due to a problem 
during installation. 
Re-install the application.

Your computer has the wrong 
DLL version. 

Installation may have failed, so 
re-install the application.   

A problem occurred while 
reading file <file name>.
The disk being read from may 
be damaged or may not exist. 
Check the disk and try again.

A problem occurred while 
reading from a disk. 

Check the disk for data 
corruption and confirm that the 
disk exists. Then try again. 

A problem occurred while 
writing file <file name>.
The disk being written to may 
be damaged or may not exist. 
Check the disk and try again.

A problem occurred while 
writing to a disk. 

Check the disk for data 
corruption and confirm that the 
disk exists. Then try again. 
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Message Description Required Action

A problem occurred while 
reading file <file name>.
The file may have been moved 
or deleted.

A problem occurred when you 
tried opening a file from the list 
of previously opened files on 
the File menu.

Check to see if the file has 
been moved or deleted. 

There is not enough memory.
Increase memory capacity and 
try again.

There is not enough memory to 
perform the operation. 

Increase memory capacity and 
try again. 

A problem occurred while 
launching the emulator.
Try re-starting the application.
If you still cannot launch, it 
could mean that the emulator 
is damaged. Update 
the emulator or reinstall it.

A problem occurred during 
emulator startup. 

Try restarting the application.
If this does not work, it could 
mean that the emulator is 
damaged. Update the emulator 
or reinstall it. 

A problem occurred while 
launching the manual (***.pdf) 
viewer.
Download the viewer from the 
site below and reinstall it.
http://get.adobe.com/reader/
otherversions/

A problem occurred during 
manual viewer startup. 

Download and install a new 
viewer from 
http://get.adobe.com/reader/
otherversions/.

The following characters 
cannot be used in a Key-Log 
record name.
:\ /?*[ ]

The Key-Log record name you 
are trying to use contains an 
illegal character.

The following characters are 
not allowed in Key-Log record 
names. 
:\ /?*[ ]

A system error has occurred. 
(1) Shut down all other 

applications that you are 
not currently using. 

(2) Check how much free 
space is available on your 
computer’s hard disk. 

(3) Exit the emulator and 
restart it. 

If this does not correct the 
problem, it could be the 
emulator files have been 
corrupted.
Please reinstall the emulator.

—

Follow the steps that are 
shown on the display and try 
again.

The path and/or filename 
exceeds the maximum length 
allowed by your Windows 
operating system.

The number of letters in the 
path or file name you specified 
exceeds the allowable limit. 

Shorten the specified path or 
file name. 

http://get.adobe.com/reader/otherversions/
http://get.adobe.com/reader/otherversions/
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Message Description Required Action

A problem occurred while 
importing <file name>. 
Note that import of a file 
created on another model is 
not supported.

Some problem occurred while 
importing the file. 

Make sure that the file was 
created using a calculator with 
the same model name as this 
calculator. 

A Key-Log file cannot be 
created or opened while Key-
Log data is being played back 
or recorded.
Stop playback or recording  
and try again.

You are trying to create a 
new Key-Log file or open an 
existing Key-Log file while  Key-
Log data is being played back 
or recorded on the calculator. 

Stop playback or recording and 
try again. 

File Extension Error The file you selected has an 
invalid file name extension. 

Make sure that the extension 
of the file you are selecting is 
bmp or jpg. 

<path> Invalid Extension The file path you selected has 
an invalid file name extension. 

Make sure that the extension 
of the file path you are 
selecting is bmp or jpg. 

A problem occurred while 
accessing the registry.
Check to make sure that the 
emulator is installed correctly.

Some problem occurred during 
registry access. 

Re-installation of the emulator 
is recommended. 

A system error has occurred. 
Exit the emulator and restart 
it. If this does not correct the 
problem, it could mean that 
the emulator file is damaged. 
Reinstall the emulator.

A system error occurred. Re-installation of the emulator 
is recommended. 

Invalid File Name You specified an invalid file 
name. 

Make sure that you are 
specifying the file name 
correctly. 

Invalid Folder Name You specified an invalid folder 
name.

Make sure that you are 
specifying the folder name 
correctly. 

Too Many Files Selected The number of files you 
selected exceeds the allowable 
limit. 

Reduce the number of selected 
files.

This data was created by a 
different model or different 
version. Because of this, some 
key names may be wrong. 
Though the Key-Log will play 
back, some operations may 
not be performed correctly.

You are attempting to open 
a Key-Log file (g1k) whose 
version is older than that of 
the software you are currently 
running. Note that operations 
may not match the operations 
in the Key-Log file.

—
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k Screen Receiver

Message Description Required Action

A connection could not be 
established.
Either the calculator is not 
connected or the connected 
calculator is not in the Screen 
Receiver Mode.
Correct the problem and try 
again.
For details, select the following 
on the menu bar: Help - 
Manual - Manager PLUS, or 
refer to the Manager PLUS 
user’s guide. 

You started a data 
communication operation 
while the USB cable was not 
connected. 

Check for proper connection of 
the calculator to the computer 
and confirm that the calculator 
is in the Screen Receiver 
mode. Then try again. 
See “10. Using Screen 
Receiver to Display the 
Calculator Screen Image on 
Your Computer” for details.

A problem occurred during 
communication.
Disconnect the USB cable, 
check the setup of the 
calculator, and try again.
For details, select the following 
on the menu bar: Help - 
Manual - Manager PLUS, or 
refer to the Manager PLUS 
user’s guide. 

Some problem occurred during 
data communication. 

Disconnect the USB cable 
and check the setup of the 
calculation. Then try again.
See “10. Using Screen 
Receiver to Display the 
Calculator Screen Image on 
Your Computer” for details.

Multiple calculators have been 
detected.
To start communication, make 
sure only one calculator is 
connected by USB.

Multiple calculators are 
connected to the computer. 

Make sure that there is only 
one USB connection to a 
single calculator before starting 
communication. 
See “10. Using Screen 
Receiver to Display the 
Calculator Screen Image on 
Your Computer” for details.

The image could not be sent 
from the calculator.
(1) Try pressing a key on the 

calculator.
(2) Check to make sure that the 

calculator is in the Screen 
Receiver Mode.

If the screen is not sent after 
you perform the above steps, 
disconnect the USB cable and 
check the calculator setup. 
Next, reconnect and try again.
For details, select the following 
on the menu bar: Help - 
Manual - Manager PLUS, or 
refer to the Manager PLUS 
user’s guide. 

The calculator screen image 
cannot be sent for some 
reason. 

Follow the steps that are 
shown on the display and try 
again. 
See “10. Using Screen 
Receiver to Display the 
Calculator Screen Image on 
Your Computer” for details. 
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Message Description Required Action

The connection has been 
broken for some reason and is 
being restored. 
If data communication does 
not resume after some 
time, perform the operation 
described below.
Try pressing a key on the 
calculator. If the screen is 
not sent after you perform 
the above steps, disconnect 
the USB cable and check 
the calculator setup. Next, 
reconnect and try again. 
For details, select the following 
on the menu bar: 
 Help - Manual - Manager 
PLUS, or refer to the Manager 
PLUS user’s guide.

—

Follow the steps that are 
shown on the display and try 
again.
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Expat, Release 1.95.8 (MIT/X license)

Copyright © 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark Cooper

Copyright © 2001, 2002, 2003 Expat maintainers.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the “Software”), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject 
to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.

IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY 
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT 
OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR 
THE USE OR OTHER DEALINGS IN THE SOFTWARE.



CASIO COMPUTER CO., LTD.

6-2, Hon-machi 1-chome
Shibuya-ku, Tokyo 151-8543, Japan

 SA1809-G
© 2014 CASIO COMPUTER CO., LTD.


	Getting Started
	Contents
	1. Installing and Uninstalling the Software
	2. Screen Configuration
	Menu Bar
	Toolbar
	Status Bar

	3. Emulator Mode and Key-Log Editor Mode
	4. Emulating fx-9860GII Calculator Operation
	5. Using the Emulator Key-Log
	6. Configuring Options Dialog Box Setting
	7. Other Functions
	Printing
	Shortcut Menu

	8. File Types Supported by fx-9860GII
Manager PLUS
	9. Differences between fx-9860GII Calculator
and fx-9860GII Manager PLUS Functions
	10. Using Screen Receiver to Display the
Calculator Screen Image on
Your Computer
	11. Error Message Table

